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1  General Notes
First, allow us to express our thanks that you have decided on this product. We wish you total success in
accomplishing your measurement assignments with the help of imc measurement instruments and the
imc STUDIO software.

If there are any open questions about our products, please contact our Hotline .7
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1.1  Notes / Quality Management / Customer Support

1.1.1  Before you Start

Dear user.

1. The software you have obtained, as well as the associated manual are directed toward competent
and instructed users and not uninitiated one-time users. If you notice any discrepancies of this
type, we request that you contact our Hotline .

2. Necessary updates in the advancing software development can cause portions of the manual to
become outdated. If you notice any discrepancies of this type, we request that you contact our
Hotline.

3. We also request you contact our Hotline if you find material in the manual which you believe could
be misunderstood and thereby lead to personal injury.

4. Read the enclosed license agreement . By using the software, you agree to the terms and
conditions of the license agreement.

1.1.2  Quality Management

imc Meßsysteme GmbH holds DIN-EN-ISO-9001 certification since May 1995.

You can download an English version of the CE Certification on our Webpage: www.imc-berlin.de/
qualitaetssicherung. Current certificates and information about the imc quality system can be found on
the Webpage: www.imc-berlin.com in section Customer Support.

For further information, please contact our hotline .

1.1.3  imc Software and Microsoft® Windows

imc software runs on the Microsoft® Windows operating system. Microsoft Windows provides a
standardized user interface for imc software and all other Windows-applications.

imc software run under Microsoft Windows. A license for the respective version of Microsoft Windows is
required.

Microsoft, MS and MS-DOS are registered trademarks and Windows is a trademark of Microsoft
Corporation.

Intel and Pentium are registered trademarks of Intel Corporation, USA.

All other trademarks are the property of their respective companies.

© imc Meßsysteme GmbH 2013
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1.1.4  imc Customer Support / Hotline

If you have problems or questions, please contact our Customer Support/Hotline:

Germany:

imc Meßsysteme GmbH

Phone: +49 (0) 30 / 467 090 - 26

Fax: +49 (0) 30 / 463 15 76

WWW: www.imc-berlin.com

E-Mail: hotline@imc-berlin.de

For our international partners see www.imc-berlin.com/our-partners/distributor.

If you contact us you would help us, if you know the serial number of your devices and the version info of
the software. This documentation should also be on hand. Thank you!

The device's serial number appears on the nameplate.

The program version designation is available in the Info-Dialog (click on the symbol  in the menu
bar).

1.1.5  Product Improvement / Change Requests

Technical documentation will help you to use imc products. You can help us to improve our
documentation by giving us feedback on the following questions:

What terms or descriptions are incomprehensible?

What additions and enhancements you suggest?

Where have material mistakes slipped in?

Which spelling or typing errors have you found?

Responses and other feedback should be directed to the Hotline  (phone / e-mail)
or by writing to:

imc Meßsysteme GmbH

Voltastrasse 5

D - 13355 Berlin

Germany

7
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1.1.6  imc Software License Agreement

imc Meßsysteme GmbH
Voltastrasse 5
13355 Berlin

Commercial register: Berlin-Charlottenburg HRB 28778
Managing director: Dr.- Ing. Dietmar Sprenger

imc Meßsyteme GmbH Software

Terms and Conditions

Governing the Use of imc Meßsysteme GmbH Software

As of: June 1, 2013

§ 1
Objects of Agreement

(1) In addition to the "General Terms and Conditions Governing Meßsysteme GmbH Deliveries and
Services to Customers", these terms and conditions apply to all contracts concluded with imc
Meßsysteme GmbH (hereinafter referred to as "imc") which involve the transfer of rights of use to
any software developed by imc (standard software, software created or adjusted specifically for the
Customer, which is recorded on the machine-decodable data carriers such as data files, databases
and database material, updates, upgrades, releases, etc., including corresponding documentation,
information and materials, hereinafter referred to as "Software").

(2) The Software is provided to the Customer as an executable object program on machine-decodable
data carriers specified in the "Objects of the Agreement". The Software's product documentation is
also supplied to the Customer either in print or on a machine-decodable data carrier. Unless
otherwise expressly agreed in writing, the Customer is not issued the source code of the Software.
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§ 2
Rights of Use, Scope

With regard to any transfer of rights of use to Software created by imc, the following provisions apply:

(1) Basic provisions

a) The Customer is granted a non-exclusive and – subject to the terms and conditions governing
the use of Software by third parties, resale and leasing – non-transferrable right of use to the
Software for its own purposes. "Use" signifies running the programs and editing the data
records.

b) Until each due fee is paid in full, the Customer is entitled to use the Software solely on a
revocable basis. If the Customer is in default with regard to the payment of fees, imc is entitled
to revoke the use of the respective services for the duration of the default. The Customer is
granted the permanent right to use copyright protected services, in particular the Software,
only upon full payment of the agreed fee.

c) The Customer agrees to undertake appropriate precautionary measures to prevent
unauthorized access by third parties to the Software. The original data carriers and the data
carries used to make copies as per the agreement, as well as the documentation, are to be
stored in a secure location. Employees are to be notified that the production of copies beyond
the scope of the agreement is not permitted.

d) If the right of use is revoked or expires due to another reason, the Customer is obligated to
return to imc the Software, the copies made by the Customer and the documentation. Provided
that a physical return of the Software and the copies is not possible due to technical reasons,
the Customer is obligated to delete such and confirm deletion to imc in writing.

(2) Reproduction

a) The Customer is entitled to make copies of the Software only if copies are necessary to use the
Software in accordance with the contract. The following are considered cases in which
reproduction is necessary: installation of the Software from the original data carrier onto the
hard disk drive of the hardware used, as well as loading the Software into the computer
memory. 

b) The Customer is entitled to create a backup copy if such is necessary to safeguard future use.
Copies may only be made for other purposes after prior written consent has been issued by
imc. 

c) The Customer is not allowed to make any reproductions other than those expressly permitted
under the provisions of this agreement.
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(3) Use of the Software by Third Parties, Resale and Leasing

a) The Software may be used for the purposes stipulated in this contract, in particular for the
Customer's business operations. Access to the Software may also be provided to parties which
rely on using the Software as instructed by the Customer. In particular, the Customer is entitled
to operate the Software or allow the Software to be operated on data processing devices,
which are located on the premises of and are directly owned by a third party company
(outsourcing). The prohibition against multiple use remains unaffected. 

b) The Customer may permanently sell or give the Software to third parties provided that the
Customer is granted permanent use of the Software. In the context of its period of use, the
Customer may temporarily transfer the Software to third parties for a fee or free of charge. The
prohibition against multiple use remains unaffected. The Customer is expressly notified that
transfer to third parties is not permitted and use by third parties is technically not possible if an
individual license must be acquired or an individual activation is required for third party usage,
such as in the case of runtime licenses.

c) With regard to the valid use of Software by a third party, the Customer is obliged to ensure that
the third party acknowledges the provisions of this agreement governing the rights of use as
binding for such third party. The Customer may not transfer Software and documentation to
third parties if there are grounds to suspect that the third party may infringe upon the
provisions of this agreement governing the rights of use, in particular with regard to the
unauthorized production of copies. 

d) Subject to the provisions stipulated in § 4 Paragraphs 1 and 2 or a deviating express agreement
in writing, the Customer may not use the Software while the Software is being used by a third
party (prohibition against multiple use); in the event that the Software is transferred to the
third party, the customer is obliged to surrender to imc all Software copies including, if
applicable, all existing backup copies, or to destroy copies not surrendered.

(4) Decompilation

The reverse translation of the provided program code into other code forms (decompilation),
disassembling and other forms of reverse engineering of the various production phases of the
Software is not permitted. If interface information is required to achieve the interoperability of a
separately created computer program, such may be requested from imc, or a third party to be
named by imc, for a minor fee. 

(5) Changes by imc

If imc conducts adjustments, changes or enhances the Software on behalf and on account of the
Customer, the Customer thus acquires the corresponding rights of use to the changes or
enhancements of the Software to which he is entitled according to the stipulations of this
agreement.
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(6) Exceptional Usage Requests by the Customer

If the Customer requests to use the Software according to terms which deviate from the
requirements stipulated in Paragraphs 2 through 5, this exceptional use of the Software must be
agreed in writing by imc. In such an instance, the Customer agrees to provide imc with information
about the desired scope of use, the pertinent field of application, etc. If imc subsequently grants a
license covering the Customer's special intended use, the parties agree that a new license fee is
owed by the Customer, which is independent of payments made by the Customer for the previously
existing license.

§ 3
Copyright, Protection of the Software

(1) The intellectual property, in particular the copyright as well as all industrial property rights and
trade secrets, are retained by imc and are not transferred to the Customer. The Customer's
ownership of the machine-decodable data carries and data processing units remains unaffected.

(2) Copyright notices, serial numbers as well as designations and reservations of rights which serve as
program identification or a protective right may not be removed or changed. The Customer is
obliged to transfer the existing protective right notices to all copies. In particular, backup copies of
the Software must be expressly designated as such. 

§ 4
License Types, Multiple Use

(1) In the case of a Single-User License, the Software may be activated and run on only one data
processing unit. “Activation” refers to the process of transferring the license to the data processing
unit.

If the technical specifications for the Software permit a second activation, then the Customer may
additionally activate the Software on a second data processing unit. However, the Software may
only run on one data processing unit at any one time, not on both simultaneously.
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(2) With a Network License, the Software may be run on as many data processing units as the amount
of licenses obtained. In this case a central data processing unit acts as the license server for which
the activation process is performed.

If the technical specifications for the Software permit a second activation, then the Customer may
additionally activate and run the Software on as many data processing units as the amount of
licenses obtained. However, these additional data processing units must be used by the same users
who operate the Software via the license server.

(3) Subject to the provisions in Paragraphs 1 and 2 or a deviating express agreement in writing
regarding network use, multiple use of the Software is not permitted.

(4) If the data processing unit is changed, the Customer is obliged to delete the Software from the hard
disk drive of the previously used hardware.

§ 5
Trial Version

If the Software used is a free trial version, then the following additional limitations apply: 

(1)  The trial version only entitles the user to test the Software. In particular, commercially productive
utilization is not permitted.

(2)  The rights of use granted expire after the elapse of a period stated in the product description.

§ 6
License Key

(1)  The Licensor may, after serving the customer 3 months written prior notice, terminate this contract
after 12 months at the earliest. This contract can be terminated by either party with immediate
effect if important grounds exist. This is especially relevant to noncompliance with the stipulations
in § 2 (Scope of Use) and § 3 (Protection of Licensed Material). 

(2)  Upon receipt of notice of termination, irrespective of its date and grounds, the Customer is
obligated to return the original and all copies whether complete or partial of the licensed material
to the Licensor. In the case of licensed material copied onto machine-decodable data carriers which
are the property of the Customer, the Customer is obligated to destroy completely the copies
rather than to return them.
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§ 7
Conclusion

(1)  The law of the Federal Republic of Germany shall apply under exclusion of private international law.
The provisions of the UN Convention on Contracts for the International Sale of Goods (CISG) do not
apply.

(2)  The place of performance for all obligations arising from this agreement is imc's registered seat.
Insofar as the Customer is a merchant as defined by the German Commercial Code (HGB), a legal
entity under public law, or a special asset under public law, the exclusive place of jurisdiction for all
disputes directly or indirectly arising from the contractual relationship is agreed as imc's registered
seat. The same applies to persons who have no general place of jurisdiction in Germany, as well as
to persons who have moved their place of residence or usual whereabouts abroad since conclusion
of the contract, or whose place of residence or usual whereabouts is unknown at the time the
action is filed. In addition, imc is entitled to file suit at the statutory venue.

(3)  Oral side-agreements are not valid. Deviating or supplementary conditions as well as modifications
of this contract, including this written requirement clause, are only valid if agreed in writing and
expressly marked as a modification or supplement. 

(4)  All disputes arising from or in association with this agreement are to be resolved by an arbitration
tribunal under exclusion of the public courts. The arbitration tribunal also rules on the valid
interpretation of this arbitration clause. The arbitration tribunal consists of three arbitrators. The
arbitrators, which are to be appointed by the parties, must be qualified to hold the office of a judge
in the Federal Republic of Germany. The chairman must be an active or retired judge of the Federal
Republic of Germany. With regard to appointing the arbitrators, § 1035 of the German Code of Civil
Procedure (ZPO) applies. Multiple plaintiffs or defendants may only mutually appoint an arbitrator.
The place of the arbitration proceedings is the registered seat of imc. The language of the
proceedings is German. In addition, the provisions of the Tenth Book of the ZPO are applicable to
the arbitration proceedings. The arbitrators receive customary remuneration as well as
compensation for expenses. As soon as the participation of the public courts is necessary, the
competent courts at imc's registered seat have jurisdiction.

(5)  If certain provisions of this contract are inoperative or unfeasible, this does not prejudice other
provisions of the contract. The contracting parties agree to contractually substitute an operable
provision which approximates the commercial intention of the contract as closely as possible for
any inoperable one.
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1.2  Documentation

Help

All imc STUDIO products come with help (CHM format). In the menu bar, click on the symbol  to
open the help. The help files have a modular structure, so the scope of the help files depends on the
product installed. The help may also contain parts shared imc software components. These parts may
differ from the rest of the help in terms of style and structure. All help files are equipped with a full
text search functionality and have an index.

Tip for printing out help chapters

In order to change the page setup (margins, headers and footers), start the Microsoft Internet
Explorer and use the menu File > Page setup. There is help available in the Internet Explorer for this
purpose.

Notes on screen shots

The screen shots appearing in this documentation were created with a variety of Windows
versions and their appearance may thus differ from that of your installed program.

imc STUDIO works with user groups and access rights. The user group has wide-reaching influence
on the visibility and/or operability of menus, icons, etc. Note that in all imc STUDIO documents the
administrator roll is assumed to be filled. All descriptions are therefore related to the full
utilization of the user interface.
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2  Overview
This document describes the first steps in operating imc STUDIO and the installation of additional imc
products.
This document uses textual references to the product documentation.

imc STUDIO is the common framework forming a product package through the combination of modular
components (plug-ins).

Which plug-ins are available depends on the product installation (order). 

The imc STUDIO framework includes common functions:

Projects, Experiment templates and Experiments

Data management

Open / Save experiments

Saving / Loading views

User administration and Access rights

Navigation Pane , Logbook

Version Information

Documentation / Help

Start here

System requirements

Installation / Uninstall

Product Configuration / Licensing

Device connection / Network / Firewall

Customer Support - Hotline

Questions or problems? Contact our Customer Support / Hotline .

54
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3  Setting Up

3.1  System requirements

3.1.1  System Requirements

Supported operating Systems

Windows 8

Windows 7 (32 bit; recommended: 64 bit)

Windows Vista (32 bit) as of SP1

Windows XP (32 bit) as of SP3

Minimum requirements for the PC 1

Hyper-threading or Dual Core processor with 2 GHz clock rate

2 GB RAM / 4 GB RAM for Windows 7 and 8 (64 bit)

10 GB free hard disk space (NTFS format)

For installation of the software via DVD an appropriate drive is needed

Color graphics (16-bit color resolution )

Screen resolution 1280 x 768
1 A system with minimum requirements is not adequate for connection with multiple devices and complex design tasks with the
imc STUDIO Developer. Use such systems preferably only for data monitoring purposes.

Recommended configuration for the PC

Quad Core processor with 2 GHz clock rate or higher

3 GB RAM (32 bit) / 8 GB RAM (64 bit)

10 GB free hard disk space (NTFS format)

For software installation via DVD an appropriate drive is needed

True-Color color output (32-bit color resolution)

Screen resolution: 1280 x 1024 or more

Windows 7 or 8 (64 bit)

3.1.2  Devices Supported

Which devices are able to run imc STUDIO is stated in the documentation on the plug-in Setup. In order
to use imc STUDIO Monitor, the devices must have at least 32 MB internal memory available.
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3.2  Installation - Preparation

Product Configuration / License

Software requires a license. This means that the program may only be started upon obtaining a
license (see Product Configuration / Licensing ).

Administrator rights required

In order to be able to install or uninstall products, you must be registered with a user account
possessing administrator rights to the PC.

However, if you are only logged on to your PC without administrator rights, log off and log back on
with an administrator user account. Without an administrator user account, you will need the
support of your system administrator or IT department.

See also Notes on Windows User Account Control .

Restarting the computer in the process of installation

During the installation process, the installation program will prompt you to restart the PC.

Notes on restarting

After the restart, login with the same user account in which you had previously begun the
installation.

Installation update

When you perform an update from an older version (e.g. 3.x or 4.x) to the current version of
imc STUDIO, it is possible to adopt some of the settings from the older versions.

Update with the help of the existing database (recommended)

If you wish to continue using the existing database, the possible settings will be adopted.
See: Update with the help of the existing database .

Update: Adopting the settings without using the existing database

If you wish to use some settings such as the Views without using the old database, you must save
and import the particular settings.
See: Update without using the existing database .

Procedure / Overview

Follow the installation program instructions. See chapter: Installation step by step .

The installation process first checks whether the additionally required system software is
installed. If ones is missing, it will be installed automatically.

After restarting the system, the selected imc products are installed.

After the installation is concluded, it is possible to start imc LICENSE Manager directly to
activate your license.

Once the license has been activated, you can use the products.

36
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Uninstalling

To uninstall the product, use the Windows Control Panel and select the respective entry:

Control Panel / Add or Remove Programs (Windows XP) or

Control Panel / Programs (Uninstall a Program) (Windows Vista / Windows 7)

3.2.1  Update with the help of the existing database

If you continue to use the existing database, whatever settings are possible will be adopted. This includes
Views, any Setup-columns created by the user, the user administration (only 4.x) and all experiments.

Notes on the database

It is impossible to use the imc STUDIO database by both versions in parallel.

If the same path in the new imc STUDIO version is selected, you will be notified. A dialog for
performing conversion appears. There, among other things, you can convert the database or have it
copied beforehand.

Once the database has been converted, it can be used by the current imc STUDIO version.

Using new views

Be aware that the new version provides new functions, such as new or enhanced Setup pages and
new menu items.

Use of the new Views is recommended! (necessary for 3.x, if you do not wish to use the simplified
menu guidance ).

User-made columns such as meta data columns are not automatically inserted into the pages. The
configurations of these columns, however, is adopted from the old View. You can re-insert these
columns at the desired position (by means of the Column Chooser).

Multiple new views are provided. Select the Complete-View and add whatever Setup pages are
required or saved, and save the view under a new name.

How to save Views is explained in the imc STUDIO documentation under imc STUDIO (general) >
Ribbon > View Menu.

3.2.2  Update without using the existing database

In the older imc STUDIO version (3.x), various settings were saved in the so-called Application Settings.
These are mainly the view settings: user-defined views, column configurations (e.g. metacolumns).

As of version 4.x, these settings are saved with the respective project and apply to all the experiments it
contains.

In order to retain these settings in the new version after having performed the update without using the
existing database, export of the settings are necessary.

39
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Backup settings in imc STUDIO 3.x

In order to save the current view settings, proceed as follows:

Setup the view as desired

Save the current view as <default>: to do so, open the View menu, choose command Save
current view as <default> in application settings

Alternatively, you can save the current view under a name of your choice

Open the Filter menu, choose the Import / Export command

Choose option Export and then the list item Export views, metacolumns, sensors, ...

Choose an appropriate file name and path for the backup file

Backup settings in imc STUDIO 4.x

In order to save the current view settings, proceed as follows:

Setup the view as desired

Save the current view as <default>: to do so, open the menu View > Views, choose command
Save As

Alternatively, you can save the current view under a name of your choice

Open the Filter menu, choose the Import / Export command

Choose option Export and then the list item Export views, meta data columns, sensors, ...

Choose an appropriate file name and path for the backup file

Restore settings

In order to import the View settings to the current project, proceed as follows:

Open the Project menu, choose the Import / Export command

Choose option Import and then the list item Import views, meta data columns, ...

Choose the backup file

Thereafter you will see a dialog allowing you to load either all or individual view settings.
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3.2.3  Notes on Windows User Account Control

Do not change the user account

With Windows Vista or Windows 7, installation can be started without administrator rights. In this
case, the operating system requires selection of a user account and associated password, as shown
in the example below. Do NOT continue with the installation in this way, otherwise it will be
incorrect. Select "No".

Example of a password request.
Select "No".

Do NOT try to continue the installation.

Confirm the prompt by the user account control

When you are logged in to a user account possessing administrator rights, you may receive a prompt
by the Windows User Account Control (UAC) to allow changes. Select "Yes" as shown below.

Select "Yes", to start the installation.
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3.3  Installation Step by Step
Actual texts appearing in the user interface may differ from those shown in the screen shots, depending
on the product configuration (path/version name).

Installation from the product DVD

Close all programs.

Insert the product DVD.

In usual cases, the Setup program will automatically start after a brief delay.

Otherwise use the Windows Explorer and start the installation program from the DVD.

Installation after Download

If you have obtained the product electronically (download, Email), simply start the installation
program manually.

Installation language settings (language after starting the software)

When you start the installation, you first see a dialog for selecting the installation language:

Selecting the language during installation

Performing installation

Once you have selected the language, the installation setup starts with a welcome page:

Installation setup welcome page
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On the installation setup's next page, you are offered the following choices:

open the Readme-file,

open the Getting Started-document,

install the Adobe Reader, which is required for opening PDF documents, e.g. the First Steps
document

separate installation of imc LICENSE Manager and

display of the DVD contents.

Before starting installation

You must accept the license agreement to continue the installation.

License agreement
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In the next step, select the file path where the products should be installed. For each imc product, a
separate subfolder is created in this path.

Entering the installation path

Now you can select which components should be installed. There are three types available:

Demo

Auto

User-defined

However independent from the selected installation type the products that are always included are:

imc LICENSE Manager for managing the licensing, and

imc Shared Components, proving common components of the imc products, such as the curve
window.

Details on the types and the respective subsequent installation steps are provided in the associated
sections below.

Note on re-configuring imc STUDIO

Regardless of which variant of the installation is selected, when imc STUDIO is installed, all components/
plug-ins are included. This way, after successful installation it is possible to adapt the configuration at
any time by means of the Product configuration  and to select the appropriate edition.

24
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3.3.1  Demo and Auto

The installation types Demo and Auto are only slightly different. For both types the installation settings
are already configured. If you need further settings please choose the user-defined installation type .

Demo

Selecting Demo installation

Who should select the Demo installation

Use the installation type Demo in order to test the full scope of imc STUDIO for 30 days. No other
products which require a password will be installed.

Along with imc Shared Components and imc LICENSE Manager, the installation type Demo installs:

imc STUDIO Developer (Demo),

imc DEVICES,

imc FAMOS Reader + Enterprise (Demo) and

imc Format Converter.

The associated Demo license must be activated after concluding installation by means of
imc LICENSE Manager, otherwise it is not possible to start imc STUDIO. Once the demo trial period has
elapsed, use the Product Configuration  to covert the edition to the license you have purchased.

The imc STUDIO edition and the necessary components/plug-ins can be adapted at any time subsequent
to successful installation by means of the Product Configuration .

The imc FAMOS Reader is freeware which also needs to be registered using imc LICENSE Manager.

Installation start follows directly (see: Starting the installation ).
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Auto

Selecting Auto installation

Who should chose the Auto installation

Use the installation type Auto in order to install the standard imc STUDIO edition including all necessary
components. Optionally, the password-protected sensor management system imc SENSORS is installed.

The installation type Auto is installed along with imc Shared Components and imc LICENSE Manager

imc STUDIO Standard,

imc DEVICES,

imc FAMOS Reader

optionally imc SENSORS and

imc Format Converter.

The edition imc STUDIO Standard requires the purchase for license. By contrast, imc FAMOS Reader is
freeware. Both products must be activated by means of imc LICENSE Manager, otherwise the programs
can not be used.

The imc STUDIO edition and the necessary components/plug-ins can be adapted at any time subsequent
to successful installation by means of the product configuration .36
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Optionally, imc SENSORS is installed, which is a tool for administering sensors. This product requires a
password for installation. If you do not wish to install imc SENSORS, you can de-select it:

Password prompt for imc SENSORS

This additional step follows immediately upon selection of this installation type. After entering the
correct password, or selection of the imc SENSORS installation, the installation starts (see: Starting the
installation ).

3.3.2  User-defined

This installation type enables the user to choose a detailed configuration.

Based on your selection of components desired, different installation steps are displayed.

Who should select User-defined installation

Use the installation type User-defined if you wish to configure the products individual components.
With this type, it is possible to install password-protected components. Further, you can install and
configure additional imc products such as imc SEARCH or imc FAMOS (to different degrees). Note that
some components can require a separate license. For imc STUDIO, it is additionally possible to install all 
available language packages.

33
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Selecting components

Once you have selected the installation type User-defined, it is possible to select/de-select the desired
components in the box at the bottom:

Selecting User-defined installation

imc LICENSE Manager and imc Shared Components are included, as well as the necessary system
component, otherwise the installed products will not function properly.

Required system components System components require using of imc products.

imc LICENSE Manager imc LICENSE Manager enables the display and activation of all imc
software products requiring a license.

imc Shared Components Shared components of the imc products, such as the curve window.

imc SENSORS imc SENSORS is a turnkey database program applicable across
different measurement devices, for administering and editing freely
definable sensor information.

imc STUDIO imc STUDIO is modular software platform handling all aspects of
modern measurement technology from simple data acquisition to
sophisticated test configurations.

imc DEVICES imc DEVICES allows either completely manual or totally automated
setting of all measurement parameters, real-time functions, trigger
machines and data saving modes. imc DEVICES must be installed in
order to use imc STUDIO.

imc FAMOS imc FAMOS is a program for analyzing, evaluating and documenting
measurement results.

imc Format Converter Converts imc measurement data to other formats such as EXCEL and
ASCII.

imc SEARCH Provides an interface for administering and saving the measured
data in an external database system.
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Required system components

In the next step, the system components which the products selected require are displayed, along
with a note about which are already installed on your system. It is also possible to re-install any
already installed components. Which components are missing/present depends on the system and it
update status, so that the illustrations below are intended as an example only.

Required system components (example)

Configuring imc Shared Components

Configuring imc Shared Components

In this installation step, it is possible to install password-protected components of
imc Shared Components.

COM Products The imc COM programming interface is a system integration tool 

Class Counting Kit Function library for imc COM products

Spectral Kit Function library for imc COM products

Video

imc FAMOS COM-Interface Execute imc FAMOS-Sequences in imc STUDIO (only available with
imc FAMOS Professional or higher)
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Password for imc SENSORS

If you have selected imc SENSORS, you are prompted to enter the password prior to installation. But if
you do not wish to install imc SENSORS, de-select it here.

Password prompt for imc SENSORS

 Configuring imc STUDIO

Configuring imc STUDIO

It is possible to make settings for your licensed product edition here. In consequence, later product
configuration  can be omitted.

Licensed edition Information on the editions is provided in the Technical datasheet
for imc STUDIO.

Install all languages This option installs imc STUDIO in all available languages. If you do
not need any extra languages, you can shorten the installation
process.

Please note that some functions require other languages. E.g.
foreign-language parameter sets can only be imported if the
corresponding language is installed.

If the option is de-selected, then English and the operating system's
language (if available) are installed automatically. If desired, all

36
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other supported languages can be installed later (see section 
Installing additional languages ).

imc STUDIO Monitor License-required component for imc STUDIO

Links Program starting links can be created either on the Desktop or in the
Quicklaunch bar.

56
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Configuring imc DEVICES

Configuration imc DEVICES

Here, you can install optional components of imc DEVICES:

CAN, LIN, ETHERNET, XCPoE, Flexray,
PROFIBUS, IPTCom, MVB

For measurement devices with one of these Fieldbus
terminals

J1587 For measurement devices with a J1587-Bus terminal

ARINC/AFDX For measurement devices with a ARINC- or AFDX-Bus
terminal

Extension for Windows-Explorer Access to the device hard drive via the MS Windows-Explorer

LabVIEW(TM) VIs Library for accessing the imc devices via LabVIEW(TM)

Configuration imc DEVICES (password-protected)

In this step, you can add the password-protected components for imc DEVICES to the installation:

COM imc µ-MUSYCS Installation of the ActiveX components

imc Online FRAME Installation of the imc Online FRAME Workbench with Compiler

CAN Database - Import Vector database linkage, DBC-Format

Service Service support. Install this component only if requested by
Customer Support.
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Configuring imc FAMOS

Configuration of the imc FAMOS installation

In this step, you configure the imc FAMOS installation. Select the editions you wish to install. Note
that all editions except the Reader-Edition require a license. In the right column are optional
components which you can install along with imc FAMOS.

Follow the Assistant's instructions and select your preferred language for the help files and example
files like projects, sequences and dialogs. Select any optional components which you wish to install
along with imc FAMOS.

For imc FAMOS, a separate installation folder can be selected. The installation folder must be on the
PC's local hard drive. imc FAMOS cannot be installed on a network drive.

Additionally, a folder for sample files is needed.

imc FAMOS editions

More detailed information on the imc FAMOS editions is provided in the imc FAMOS manual.

Configuring imc SEARCH

Configuring imc SEARCH

For imc SEARCH, you can specify whether you wish to install a sample database.
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Once all products have been configured, the installation can start.

3.3.3  Starting the Installation

You are notified that restart of the system is necessary for successful installation. For this reason you
should close any running programs.

Concluding the installation setup and starting installation

Next, the necessary system components are installed:

Installation of the necessary system components
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Once this part of the installation process has been concluded, the system must be restarted, so the
following message is posted:

Restarting the system

As soon as you click on OK, the restart is performed.

Warning

After restarting, be certain to log in with the same user account with which you started the installation
process. Using a different user account can cause failure of correct installation of the components. 

After logging in, the actual installation of the products begins. You are presented with a list of which
components are to be installed, which you can confirm by clicking on Install. The figure below shows an
example; the actual dialog may appear differently depending on your respective previous selections.

List of components to install, following restart
(example)

Next, installation of the individual imc products begins.

Disabling the system start

While installation is running, the operating system is disabled from starting again, meaning that no other
programs can be started.
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When installation is finished, the following message is posted:

Concluding installation

Next, you can start imc LICENSE Manager in order to activate your license. It is also possible to start the
imc LICENSE Manager later via the Start menu.
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3.4  Product configuration / Licensing
imc STUDIO can be ordered and licensed/activated in various product configurations.

Further details can be found in the order forms or on www.imc-berlin.com. For a list of all possible
editions and plug-ins, see the imc STUDIO Technical datasheet or contact our Hotline .

imc STUDIO editions

imc STUDIO Standard imc STUDIO-STD

imc STUDIO Professional imc STUDIO-PRO

imc STUDIO Developer imc STUDIO-DEV

imc STUDIO Runtime imc STUDIO-RUN

For the Edition Standard, Professional or Developer, the corresponding license is required. These can be
activated in the imc LICENSE Manager.

The Edition Runtime is a freeware version. You can register this edition in the imc LICENSE Manager.
There, select the option "Trial versions and freeware".

Basic packages and optional packages

In supplementation of the basic edition, additional components (plug-ins) are available. For some of
these plug-ins, a separate license is required. A list of all available plug-ins is provided in the technical
datasheet for imc STUDIO.

Licensing (imc LICENSE Manager)

In this version of imc STUDIO, the software license is managed with imc LICENSE Manager.

After concluding installation, you can start imc LICENSE Manager directly in order to configure your
license. If imc STUDIO is started without an appropriate license having been configured, the product
configuration program opens, from where it is also possible to start imc LICENSE Manager.

imc LICENSE Manager offers a separate documentation which describes imc LICENSE Manager in
detail. Start imc LICENSE Manager and click on Help.

If you have not yet activated a license for the selected product configuration, start the
imc LICENSE Manager (e.g. by means of the corresponding entry in the Windows Start menu: for XP: 
All Programs > imc > imc LICENSE Manager).

Follow the instructions of the imc LICENSE Manager.

7
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Changing the product configuration

You can change the product configuration in order to adapt it to the license purchased. For instance,
if during installation you have selected a different edition or if you have purchased a product
upgrade. 

To do this, start imc STUDIO and click in the menu bar (top right) on the symbol . The assistant for
configuration the product opens. You can change (upgrade/downgrade) the configuration to
correspond to the licenses you have purchased. Follow the instructions and close the assistant.

Assistant for altering the product configuration

After completing the configuration, you must close and restart imc STUDIO for apply settings.
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3.5  Start

Desktop Icon, Quick Launch Icon

Further, as part of installation an icon is set up on your desktop and - depending on
your choice during installation  - a symbol in the quick launch toolbar.

If no icon was set up (installation  option), then open the Windows Start menu. There you find
under "Programs" the folder "imc" and in it a link to start the product.

If Product Configuration / Licensing  is missing, the imc LICENSE Manager  starts automatic.

Splash screen

Next, a splash screen appears, indicating that software components are being loaded. Depending on
the installation and the PC capacity, this could take some time.

Loading the software components after start

21
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Start page

You see the start page of the installed product, as seen in this example:

Welcome Page (Example)

Along with installation of imc STUDIO, a number of Views are provided. Views in this sense are
defined designs for the user interface’s appearance.

imc STUDIO offers a wide variety of possibilities and functions, but the entire scope of these is not
always needed for a single simple measurement.

imc STUDIO starts with a simplified view

In order to make it easier to get familiar with the software, the program starts with a simplified
view with limited choices. All important functions for measurement and visualization of measured
data are available. The menu ribbon is structured in such a way that proceeding from left to right
accesses all of the Main windows .

You can switch to a different view at any time, in order to obtain access to all of the existing
functions. To do this, go first to the menu item Extra > View and in the drop-down list of views,
select: Complete.

In order that this view also be used the next time imc STUDIO is started,  save the view as <default>:
Menu item Extra > View > Save as. Select from the list: <default>.

Notes on the descriptions and the screenshots

The following descriptions and screenshots always pertain to the view with the full scope of
functions. Many of these functions are also found in the minimized view at another location.

41
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3.5.1  Device Connection / Network / Firewall

To use an imc measurement device, imc STUDIO must set up a connection via a network (mostly LAN).

Details are described in the imc STUDIO Help in the chapter Connecting to and configuring the network
.

Skipping the network settings

If you have used the predecessor device control software imc DEVICES in the past, you can skip these
steps, as the network configuration of the PC and the devices need not be changed for imc STUDIO.

Firewall

Depending on the operating system settings in effect and on the software previously installed, the
first time you start the program and access a device connected to the LAN (e.g. by means of the
device search), you see a prompt from Microsoft Windows to clear imc STUDIO (imc DEVICES and
imc DEVICES Service) for the Firewall.

For Windows 7 SP1, the prompt appears as shown below:

Windows Firewall Warning (Windows 7)

Windows XP: For undisturbed operation of imc STUDIO, you must select "Unblock".

Windows 7 and Windows Vista: here, there is a distinction between private and public networks. For
operation on LAN, it is sufficient to enable "Private networks". You may wish to read the online
documentation on imc STUDIO and / or ask your administrator / IT-specialist.
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3.5.2  Plug-ins / Main Windows

imc STUDIO provides the framework for plug-ins. Plug-ins appear within imc STUDIO as main
windows. A plug-in can have one or more main windows.

The main windows appear in the Navigation Pane.

On the left you see an example of the Navigation Pane with the main windows Start Page,
Setup, Panel, Automation and Sequencer (Panel is selected).

To jump to one of the main windows, click on the corresponding button in the Navigation Pane.

Navigation Pane : Select this link to go to further information on operation of the Navigation
Pane.

Notes on the use of the simplified view

When you use the simplified view , the Navigation Pane is hidden. In this case, in order to
go to the main windows Setup and Panel, use the menu ribbon.

The other main windows can only be reached via the Navigation Pane.

If you need it, you can show the Navigation Pane , or change the view.

Homepage

By default the Start page is shown when imc STUDIO is started. The Homepage shows certain functions,
depending on the particular product, as buttons. Click on the corresponding buttons, to select your
desired functions.

Tool window

Most plug-ins have their own tool window (e.g. the Panel with the tool windows: Widgets and
Data Browser). The tool windows are described in their respective sections.

Tool window : Select this link to go to further information on operating the tool windows and for a
description of the tool windows belonging to the imc STUDIO frame.

3.5.3  Important Settings

User and User groups

imc STUDIO has the ability to administer various users which are permitted to use the program in
various ways. For details see the section User administration.

  

Options

Before beginning to work with imc STUDIO, you can change essential settings, such as the folder
path where the experiments are saved:

Select the item Options in the Extra menu

To change the folder path, select Project Management > HDD settings

Here, you can edit the path int he database.

Reading and writing access rights are required

Please note that this setting will apply for every user of imc STUDIO. Each user must possess reading
and writing access rights for the specified folder path.
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3.5.4  Command Line Parameters

Opening an Experiment file

An  experiment file  (e.g. MyExperiment.imcstudio) can be opened directly in the Windows Explorer by
double-clicking. This starts a new instance of imc STUDIO and opens the experiment file. The same
procedure also applies for linkages to experiment files, for example files on the Desktop.

Experiments can be started with command line parameters. To do this, create a link to an experiment file
and enter the desired parameter.

["imc STUDIO-Installation"] "Experiment-File" [/fullscreen] [/do[StartMeasurement]] [/
do[StartSequencer]]

["imc STUDIO-Installation"]
Opening an experiment with a particular imc STUDIO
installation (optional)

In order to open an experiment file with a particular installation of imc STUDIO, extend the link with
the respective installation's name. For example:

"C:\ProgramData\imc\imcStudio\Applications\_2\imcStudio.exe" "C:\Users\Me
\Documents\imcStudio\MyExperiment.imcstudio"

The experiment file MyExperiment.imcstudio is started in the imc STUDIO  installation under
Applications\_2\.

"Experiment file" Experiment to be loaded

Mandatory entry. Opens the experiment entered with the imc STUDIO  installation which is set up as
the default program under MS Windows. Mostly this is the last imc STUDIO version installed, or
imc STUDIO Monitor, if this component was installed along with it.

One possibility is to specify the path in absolute terms:
"C:\Users\Public\Documents\DB\StandardProject\config\MyExperiment.imcstudio"

Another way is to specify it in reference to the name of the database and of the project (the
appropriate database folder must be selected):

"imcDB://DB\StandardProject\MyExperiment"

/fullscreen Fullscreen mode (optional)

In order to start an experiment in fullscreen mode, the experiment file is opened with the
parameter /fullscreen.

"C:\Users\Me\Documents\imcStudio\MyExperiment.imcstudio" /fullscreen

After opening the experiment file, the Panel is started in fullscreen mode, if the experiment contains
at least one Panel  page.

/do[StartMeasurement] Starting the measurement (optional)

In order to start the measurement automatically upon opening an experiment file, The experiment
file is opened with the parameter /do[StartMeasurement].

"C:\Users\Me\Documents\imcStudio\MyExperiment.imcstudio" /do[StartMeasurement]

or
"C:\Users\Me\Documents\imcStudio\MyExperiment.imcstudio" /fullscreen /
do[StartMeasurement]
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/do[StartSequencer] Starting the Sequencer (optional)

In order to automatically start Sequencer upon opening an experiment file, the experiment file is
opened with the parameter /do[StartSequencer].

"C:\Users\Me\Documents\imcStudio\MyExperiment.imcstudio" /do[StartSequencer]

or
"C:\Users\Me\Documents\imcStudio\MyExperiment.imcstudio" /fullscreen /
do[StartSequencer]
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3.6  Info / Version Information
As already mentioned, imc STUDIO consist of multiple components (plug-ins). In order to see which
components are included in your package, click in the menu bar on the symbol .

Then a pop-up window appears displaying the product names and details on the components:

Version information (example)

With the buttons on the left side, you can change the list's depth of detail and how it is sorted.

With the buttons on the right side, you can start the assistant for the product configuration , start the
imc LICENSE Manager  or export the product selection.

While performing the export, you can save the contents as a file in XML format. For inquiries for Hotline,
it may be necessary to send it as an Email (see also chapter Customer Support - Hotline ).
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3.7  Additional imc Software Products (optional)
imc FAMOS

Some imc STUDIO plug-ins (Automation, Sequencer, Panel) are able to integrate imc FAMOS for
data analysis purposes (executing sequences). imc FAMOS is a imc software for complex analysis,
display and presentation of signals on the PC ("offline"): www.imcfamos.com

imc FAMOS must be separately purchased and licensed for the PC. Details on imc FAMOS are
available in the software documentation. To execute ready to run sequences for analysis in
imc STUDIO, imc FAMOS Runtime, Professional or Enterprise is required.

imc Online FAMOS Professional

Some imc STUDIO plug-ins require devices having imc Online FAMOS Professional.

imc Online FAMOS, or its Professional version, is the software which processes data within the
measurement device ("online"). imc Online FAMOS Professional must be purchased and licensed 
along with the device.

imc SENSORS

imc STUDIO Setup can use the imc SENSORS database. imc SENSORS is a ready-to-go, universal
database application for administering and editing sensor information. In particular, the entries in
the sensor's technical data sheet as well as its calibration values are processed and managed.
Along with these values for smart sensors (TEDS) defined in IEEE 1451.4, selections of additional
sensor properties can be entered. 

http://www.imcfamos.com
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4  Navigation Pane

Maximized Navigation Pane
(example)

In the Navigation Pane, the main windows of the installed plug-ins are
displayed as a tree diagram. To open/change the main window, click on
its corresponding entry.

The Navigation pane can be opened or closed, maximized and
minimized.

To maximize/minimize the Navigation pane, click in its
top bar on the arrow symbol.

To open/close the Navigation pane, click on the upper
region of it below the arrow.

If the Navigation pane is maximized or opened, the main
windows are additionally displayed as a tree diagram (see
example shown).

Via the tree diagram, it is possible to jump to different main
windows or directly to the pages containing the main windows.
Using the arrow symbols ( ) which are in front of the main
windows, the tree diagram branch can be expanded/collapsed.

You can hide the Navigation Pane.

If you hide the Navigation Pane, please note that your ability to
navigate between the main windows. For this case, you should add the
command: Browse workspace at suitable locations, for instance in the
ribbon menu (User-defined buttons).

To show or hide the Navigation Pane use the dialog: Tool windows
chooser .49
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5  Tool Windows
Tool windows contain special elements for operating/viewing a main window. (For information on
operating the tool window: Operation )

Five tool windows
 - The imc STUDIO frame's log book

 - Four additional windows from the main window imc STUDIO Panel

One tool window belongs to the imc STUDIO frame and is always available:

Logbook

The Logbook is always displayed and can be minimized.

The other main windows' tool windows (e.g. for the Panel) are displayed as soon as the respective main
window is opened.

Not all tool windows are visible

By default, all necessary tool windows are displayed. All others can be displayed , if you need them.

48
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5.1  Operation
Tool windows contain special elements for operating and editing a main window.

Tool window (example)

Each main window has its own tool window, which is
described in the documentation of the respective
component. Tool windows can be moved and deleted.

By default, the tool windows are pinned to the main
window (e.g. at the bottom or right margin).

The picture shows an opened tool window (Details). Its
is pinned and contains two additional tabs. If you click
on one of these tabs, the corresponding tool window
opens (Dependency Tree and Column Finder).

Three other collapsed tool windows are seen at the right
margin (Sensors, Layout Repository and Table
descriptions).

A tool window is opened when the mouse is swiped
over it.

As long as a tool window is selected, or if the mouse is
located over the tool window, the tool window remains
open. Otherwise, it collapses to the side.

Pinning the tool window

Tool windows can be pinned. Pinned tool windows remain open even when no longer selected.

In order to pin a tool window, click on the thumbtack-button ( ).

Freely positioning the tool window

In order to freely position the pinned tool window, move the tool window's title bar using drag and
drop to the desired position.
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Docking the tool window

In order to dock the tool window, use the drag and drop technique by grabbing the tool window's by
its title bar and moving it to the desired position. A Dock-symbol will appear at the locations which
are possible.

In the center of the targeted window (main window or tool window), a cross
appears. To dock the tool window, release the mouse button with the mouse
over the desired position.

Dock at the top/bottom margin

Dock at the left/right margin

Insert as a tab in a different window (see example)

Showing/hiding the tool window

You can either show or hide tool windows. To do this, open the dialog: Tool window chooser

use the menu View > Layout > Tool windows, or

the button ( ) in one of the present tool windows.

The dialog: Tool window chooser opens.

Dialog: Tool windows chooser

Set a checkmark in front of the tool windows which you wish to have displayed.
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5.2  Logbook
In the tool window Logbook, messages of the categories: Fatal ( ), Error ( ), Warning ( ) and
Information ( ) are entered.

The logbook entries indicate what problems and errors exist and provide hints on where to find them
and how to remedy them. Some actions performed are documented.

E.g., a note is entered in the logbook for every command performed:

performed successfully (Information) or

otherwise Error or Warning

By default, the Logbook is opened and attached when an entry any of the categories Fatal, Error or
Warning occurs.

By default Information category notes are entered into the logbook without any further effect.

Example of logbook entries

Each logbook entry consists of:

Symbol for the category Fatal ( ), Error ( ), Warning ( ) and Information ( )

Time Time the logbook entry occurred

Code Logbook entry's error code

Message Exact description of the logbook entry

Sender The origin of the logbook entry

After a new imc STUDIO start, the logbook is empty. The logbook itself only displays messages which
occurred since the last start of imc STUDIO. Older messages can be opened with the Logbook-Viewer.

The logbook is saved

For purposes of tracing history, the logbook is saved daily:

Default path for Windows 7: C:\ProgramData\imc\imc STUDIO\Applications\_1\log (example)
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Filtering the Logbook

You can filter according to category.

Logbook filter

To do this, click on the Filter-button in the logbook's title bar:

errors

warnings

information (messages)

Usually, all categories are selected.

Filtering also takes effect on new messages

Note that the filter has an effect when a new message appears. For this reason, this message may
not be displayed.

Searching in the logbook

It is possible to search the logbook for entries and text passages.

To do this, click on the Search-button in the logbook's title bar.

An input appears. Enter the desired search keyword here. All messages are displayed which contain
the text entered.

Search also takes effect on new messages

Note that Search works like a filter and  has an effect when a new message appears. For this reason,
this message may not be displayed.

Hiding duplicates

It is possible to hide duplicates.

In certain cases, the system attempts to perform the same action multiple times in succession. In
consequence, multiple duplicate reports are displayed in the logbook.

In order to keep the logbook clear and concise, it is possible to group the duplicates. To do this, click
on the Duplicates-button in the logbook's title bar.

The first and the last messages are always displayed, thus indicating the points in time for the first
and last occurrences. In front of the displayed text for the grouped message, a number appears in
parentheses. This number indicates how many times the message occurred.
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Copying a selected message

It is possible to copy the selected message to the Clipboard.

To do this, click on the Copy-button in the logbook's title bar.

The copy contains all information which is visible in the logbook.

Deleting messages

It is possible to delete displayed messages.

To do this, click on the Clear All-button in the logbook's title bar.

Note: Delete All clears the display

Be aware that this only purge the display, but the logbook on the hard drive remains unaffected. As
well, it is still possible to view the deleted messages in the Logbook-Viewer.

Activating/deactivating automatic scrolling

When a new message is entered in the logbook, the display in the Autoscroll mode automatically
jumps to the new entry.

If you wish to investigate older messages, you can deactivate this mode.

This happens automatically when a message is selected, or click on the Autoscroll-button.

Re-activate the mode by: 

pressing <Esc>

left-clicking the mouse over the selected entry while holding down the <Ctrl> key

clicking on the Autoscroll-button in the menu

New messages are not automatically displayed visibly

Be aware that when the Autoscroll mode is deactivated, you will not be automatically notified when
new messages appear.

Sending Email

You can send the logbook via Email (e.g. to the imc Hotline).

When you click on the Send Email -button, your Email-program starts. The logbook is zipped and
attached to the Email. The imc Hotline is automatically added as a recipient.
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Starting the Logbook-Viewer and opening old logbooks

By means of the Logbook-Viewer, you can look at current, deleted and saved logbook entries.

When you click on the button, the Logbook-Viewer opens. In addition to the familiar logbook-
functions, it is possible to load saved logbooks.

Options for the Logbook

From within the logbook, you can open the Options for the Logbook.
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6  Information and Tips

6.1  Projects, Experiment templates and Experiments
This chapter describes the relationships between projects, experiment templates and experiments. How
the individual components are saved is discussed in the chapter Data Management.

Experiment

imc STUDIO saves the settings in so-called experiments. These settings include:

the experiment-file (filename extension: *.imcStudio),

measured data

metadata

various backup files

admin files

Among other things, the experiment file contains all the settings configured in the main windows
and in the Setup-Assistants.

Each experiment has a unique name which is set when it is saved.

Project

A project contains:

one or more experiment templates

one or more experiments

Project settings (e.g. views, user administration and project-events)

You can create multiple projects containing various experiments.

Upon the first start of imc STUDIO, a standard project is created in which your experiments are
saved.

Project view

To create additional projects, you must activate the Project view. This option is deactivated by
default.

Select from the menu Extra > Options > Options

Select in the Options dialog Project Management > General options

Note

Only activate the project view if you wish to use and administer many experiments in multiple
independent projects.

If this function is deactivated, some dialogs appear in simplifier form (e.g. Save experiment and
Open experiment, meaning without project selection, etc.).
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Experiment Template

If you create a new experiment, it is generated from an experiment template.

The new experiment contains all properties of the selected template. In templates, all settings which
are saved will be saved also in an experiment.

Following the first installation or after creating a new project, the project contains an "empty"
experiment template.

Making experiment templates visible

In order to be able to use experiment templates, you must previously make the experiment
templates visible. This option is deactivated by default.

Select from the menu Extra > Options > Options

Select from the Options dialog Project Management > General options

Note

Only activate this function if you wish to create multiple similar experiments.

If this function is deactivated, some dialogs appear in simplifier form (e.g. New experiment
meaning without experiment template selection, etc).
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6.2  Installing Additional Languages
If in the installation type User-defined  the option Install all languages was not selected, then upon
conclusion of the installation, imc STUDIO is available in English plus, if provided, in the operating
system's language. In all other cases all supported languages are already installed.

If desired, all other supported languages can be installed later (no data processing medium is required).

Which languages are be installed subsequently

In subsequent installation of languages, all languages supported are installed. There is no selection
possibilities.

Step by step

Administrator rights are required.

Open the  installation folder of imc STUDIO (e.g. C:\Programme(x86)\imc\imc STUDIO 4.0 R1), e.g.
with Windows Explorer or by means of the command line.

There, open the folder Languages

Run the file InstallLanguages.bat.

Wait until the script stops and posts the message Failures: 0. This indicates that the installation has
completed successfully.

Instruction notes (not applicable to Windows XP)

If installation was unsuccessful, the necessary user rights may be missing::

If InstallLanguages.bat is called via the command line, run the command line as Administrator
(context menu: Run as Administrator)

If InstallLanguages.bat is called via the Windows Explorer, run the call as Administrator (context
menu: Run as Administrator)

26
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6.3  Jiggling Display and Heavy Burdening of the Processor
The presence of many channels can burden the PC if a virus protection program scans the data captured.

We strongly recommend removing imc STUDIO from the virus scan.

Most virus protection programs are able to classify individual programs as low-risk. To do this, please
refer to the instructions for your virus scanner. 

Add the program imc.Studio.exe (= imc STUDIO) to the list of low-risk programs
The default path is: C:\Program Files\imc\imc STUDIO...

Add the database path along with all subfolders to the list of low-risk folders.
The default path is: C:\Users\Public\Documents\DB

Ensure that its data are not searched for viruses during reading or writing
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7  Setup - Connect the device
There are multiple ways to connect the imc measurement devices with the PC.

In most cases, the connection via LAN  (local area network, Ethernet) is implemented. See section
Connecting to LAN in four steps  for the quickest way to connect PC and measurement device.

But there are also other connection types:

Modem (TCP/IP with PPP)

WLAN

Radio modem (GSM, mobile phone network)

Null modem (serial interface)

These are described in a separate chapter: Special options for connecting to the device.

The devices use the TCP/IP protocol exclusively. With this protocol, some settings and adaptations for
your local network may be necessary. For this purpose, the support of your network administrator may
be necessary.

Note

If you are already using imc measurement devices with other imc programs in your network, then
settings or adjustments are unnecessary and you can skip the entire section Connecting to and
configuring the network.

When using multiple TCP/IP connections, e.g. LAN, Wireless LAN and modem, observe the remarks in
the chapter Computers with multiple TCP/IP connections.

59
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7.1  Connection via LAN
To connect via LAN there are two options:

1. The measurement device is connected to an existing network, e.g. via network hub.

2. The measurement device is connected directly to a network adapter on the PC (point-to-point).

In a LAN, the first case is typically implemented. For both variants, different cables are required!

Connecting to an existing network:

An uncrossed UTP cable, e.g. CB-UTP-3 is necessary

Connect the measurement device's LAN jack to your multi-port repeater (hub). Only with such a
hub is it possible to run multiple devices.

Direct connection to the PC (point-to-point):

You need a special "crossed" UTP-cable (Category 5, RJ45 connector, e.g. CB-UTPX-3)

Connect the measurement device's LAN connector directly with the PC's LAN jack

Recommended network configuration:

We recommend using a 10BASE-T Ethernet network (twisted pair, RJ 45) and a hub. The cable length
between the hub and a PC or a device should be less 100 m. Use a shielded cable. If the length of 100m is
exceeded, then you have to insert another hub. If the system is being integrated into an existing
network, you must ensure that the minimum data rate can be guaranteed. If this is not the case, you
should use network bridging.
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7.2  Connecting via LAN in four steps
The most common case is described below: the PC and the device are connected via cable or hub. The
device's IP-address must be set in the PC's address range. Subsequently, the device can be connected
with the PC. If a connection has ever been established previously, the software knows the device's
hardware configuration. In that case, experiment configurations can be prepared without any connection
to the device.

7.2.1  Step 1: Determining the PC's IP-address

Before you start your device configuration, you should find your PC's IP-address (the following screen
shots and texts are related to MS Windows XP).

To open the configuration dialog, use one of the following:

Open the Windows "Help and Support" function and search for the term "TCP/IP Settings", open
the first search hit and click on "Network settings"

Open the Windows Start menu, select "Run" and enter the following command in the edit box:
control netconnections

The "Network Connections" window appears:

"Network Connections" window -> "Local Area Connection"

Then right-click the mouse over the entry for your "Local Area Connection" and then select the item
"Properties" in the context menu once again.
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Then the "Local Area Connection Properties" window appears.

First click in the list on "Internet protocol (TCP/IP)" (1) und then on "Properties" (2). Please note the IP-
address (3) and your computer's subnet mask (4) as seen in the following example screen shots.

Select Internet Protocol (TCP/IP) Settings for TCP/IP

If "Obtain IP-address automatically" (DHCP) is selected, no IP address is displayed. In this case, you have
to determine the current IP-address using the Command Prompt. Note, however, that automatically
obtained IP-addresses might change the next time the operating system is started! Start the Command
Prompt via the Windows Start menu by selecting Programs : Accessories: Command Prompt and then
enter ipconfig or ipconfig /all for more detailed information:

Result of the command "ipconfig"
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7.2.2  Step 2: Connecting the measurement device

When you connect the imc measurement device directly to your PC, you must used a "crossed" network
cable (included in package, black color). If the measurement device is connected to the network via a
network hub or switch, or a patch box, use an uncrossed network cable (red color, included). Today
network hubs are able to switch electronically. Hence you can use both cable types.

7.2.3  Step 3: IP-configuration via imc DEVICES Interface Configuration

Start imc DEVICES Interface Configuration from the Windows Start menu group imc. Click on the 
symbol next to your PC's name in order to start an automatic device search. Then all available devices
appear in the tree diagram under your PC. Double-click over the device and select the item LAN.

Display of measurement devices found and of the IP-address

If the option Use DHCP is checked, the IP-address is obtained automatically from the DHCP-server and
there is impossibility of changing the settings. If there is a direct connection between the device and the
PC with a crossed cable, you should deactivate the DHCP. If it is impossible to obtain any setting values
via DHCP, the default values are used. These could lead to errors in the connection (different networks,
same IP-addresses, etc.).

Without DHCP, you must set the IP-address manually. Please note that the device's and PC's IP-address
must fit together, in other words that in the network mask only the portion representing the device is
different (see example). Analogously, you can also make modem or PCMCIA card settings.

Example for IP settings PC Device

IP-address  10.  0.  0. 34  10.  0.  0. 45

Network mask 255.255.255.  0 255.255.255.  0
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In order to apply the changes, click in the tree diagram on the device name and then on the button 
Accept. Wait for the device to restart and then close the program imc DEVICES Interface Configuration.

Accepting the network settings for the device

7.2.4  Step 4: Integrating a device into an experiment

Now you are ready to add the device to the imc STUDIO experiment. Start the program imc STUDIO.

If your device is unknown to the system, first perform the device search. Use the menu button Search

for devices ( ).

Select the desired device.

Once you click in the checkbox Selected for the desired device, it is ready to use in the experiment (see
Device is known and Selected).

You can also select multiple devices for your experiment.

Now the device is known. After the next program start it is available for selection.

For further information, see the documentation on plug-in Setup.
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7.3  Optimize the network
You should observe the following notes for networks with high data rate, to reduce the risk of a data
overflow.

1. The network between switches/hubs and PC should be 1GBit/s

2. The actual data rate is decreasing with the number of channels. Avoid unnecessary channels.

3. The RAM buffer should be as big as possible, not "Auto". See also RAM buffer time.

4. Save only channels you need to the internal disk.

5. Avoid curve window setting that need a lot of performance. Choose scroll mode. Avoid the rezoom
function after a long measurement duration. Don't set the sample points to symbols. Try to find a
curve window configuration, that shows no bucking.

6. Switch off the virus scanner!!! It would check every sample  written to the hard drive. That takes
most of the performance of a PC and the hard drive.

7. Check the processor and network load with the PC task manager
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7.4  Complex Networks
Theoretically, every type of network can possibly function. Until now, we have only considered networks
consisting of a PC and n imc-Devices units. However, it is possible for example, to have 3 PC's, two
printers and n imc-Devices units connected in a network:

The PC where the chief software components have been installed is the master PC. The software on the
master PC can also be used by the other PC's. Naturally, a few local files are created on each of the non-
master PC's to reduce the load on the master PC. This type of configuration ensures good performance
everywhere in the network.

The well-known network restrictions are also valid here. In particular, it is impossible for more than one
person to write to the same file. Furthermore, it is impossible for one person to open a file while another
writes to it. In general, all network restrictions that apply to files also apply to the individual Devices
units. For example, only one user can configure a given device.

Several network printers may be connected to several different PC's. It is recommended to use the PC
which currently has the lowest overall workload.

Using a second network 

To avoid disturbing data transfer between devices units and PC's, a second network using a second
network card per PC can be set up. This second network can be used for transferring data between the
PC's.
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